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ntroduction

Bryan Costello P.E.

» Bryan.Costello@LA.gov
» 225-379-1958

» @ Highway Safety since 2015

www.dotd.la.gov



» Introduction

» Initialization

» Crash Querying

» Site Analysis

» Quality Assurance
» Benefit-Cost

www.dotd.la.gov



AAAAAAAAAAAAAAAAAAAAA
TRANSPORTATION & DEVELOPMENT r a S O O

» Not an everything tool

» Statistics & SHSP Dashboards >
CARTS.LSU.edu > Data Reports

» Focused on project development

» Most modules finished
— Crash Query
— Quality Assurance
— Site Analysis
— Benefit-Cost

» More Training in the near future

www.dotd.la.gov
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Highway Safety Improvement Program (HSIP)

The Highway Safety Improvement Program (HSIP) is a core Federal-aid program
with the purpose to achieve a significant reduction in traffic fatalities and serious
injuries on all public roads, including non-State-owned roads and roads on tribal
land. The HSIP requires a data-driven, strategic approach to improving highway
safety on all public roads with a focus on performance.

The HSIP is legislated under Section 148 of Title 23, United States Code (23
U.S.C. 148) and regulated under Part 924 of Title 23, Code of Federal Regulations
(23 CFR Part 924). The HSIP consists of three main components, the Strategic
Highway Safety Plan (SHSP), State HSIP or program of highway safety
improvement projects and the Railway-Highway Crossing Program (RHCP), In
addition, some states also have a High Risk Rural Roads (HRRR) program if they
had increasing fatality rate on rural roads.

www.dotd.la.gov



ash Report 2022
» New Collision Manner
— Right-overtake
— Left against flow
— Backing x3
— Unknown

» More details

— Non-Motorists
— Commercial Motor Vehicles
— Intersections

» Cyclists are Non-Motorists

www.dotd.la.gov



AAAAAAAAAAAAAAAAAAAAA
T

INing Access

Send Access requests to <Bryan.Costello@LA.gov>
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Center for Analytics & Research in
Transportation Safety

About Us~ News & Events ~ Projects ~ Data Reports = Louisiana eCrash -

www.dotd.la.gov



Login

Choose how to login

Login with
CAS
(LAeCrash)

www.dotd.la.gov
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INing Access
& C & cartslsuedu/home = w % 0O e@

LSLl.edu bryan.costello & ~

Center for Analytics & Research in
Transportation Safety

About Us~ News & Events ~ Projects ~ Data Reports ~  Louisiana eCrash =
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INing Access

About Us~ MNews & Events ~

AdHoc Query
Tool

Application that allows the user to
write gueries against the data
warehouse and find results that

match those guernies.

Projects ~ Data Reports ~

CARTS User
Administration

Manage individual users and their
access, Organizations and Sub-
Organizations.

Louisiana eCrash~ Portal

Provides DOTD engineers with a

toolset to more easily identify and
analyze problematic roadway
areas by crash volume, severity,
and other factors.

.dotd.la.gov
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This crash data tool has been developed by the Office of Planning, Highway Safety Section of
DOTD for crash analysis purposes. The data contained herein is prepared solely for the purpose of
identifying, evaulating, and planning safety enhancements and/or strategies of crash sites. This is
pursuant to Section 148 of Title 23 of the United States Code and was implemented utilizing
federal-aid highway funds. Therefore, the data is not subject to discovery nor may be admitted
into evidence in a Federal or State court proceeding or considered in any action against DOTD or
the state of Louisiana.

DOTD makes no representation as to the accuracy, adequacy, reliability, availability or
completeness of the Law Enforcement Agency crash reports or the data collected from them.
DOTD is not responsible for any errors or omissions in such reports or data. DOTD is not liable for
any loss or damage incurred by any party as a result of the use of the crash reports or data
collected from them.

The data contained herein is not the official report of the circumstances of a particular crash. The
crash report and data contained within is is owned and maintained by the investigating agency. To
obtain an official copy of a crash report, contact the state or local law enforcement agency that
created it.

Pursuant to Louisiana Revised Statue 32:398, unless specifically authorized by the State of
Louisiana, third parties shall not sell or distribute any compiled data owned by the state of
Louisiana.

Questions or concerns, should be directed to the DOTD Highway Safety Section at dotd-
highwaysafety@la.gov or by calling (225) 379-1214.

DECLINE

INing Access

www.dotd.la.gov
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Crash Query Tool
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» Tools

> View
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otal Crashes: 0 Fatal Injury Crashes: 0 Injury Crashes: ( Property Damage Only Crashes: 0 bryan.costello &~
i
Crash Query Tool Manner of Collision
l Date Range Jl Location ]l Route Jl Control Section J |
101. Angle - Left Across Flow
> Query . : . Py | E’E oAl 105. Angle - ! f
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Total Crashes: 0 Fatal Injury Crashes: @ Injury Crashes: 0 Property Damage Cnly Crashes: 0 bryan.costello &~
Crash Query Tool
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Crash Query Tool

» Query
? Summary
»> Tools

> View

> Project

s~ Help
Contact Us
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crashguerytool.lsu.edu/help/intro/ & & 1

G Crash Query Tool 07 Q,

Overview Video &
Login

Overview Video
Map
Grid

Projects

Crash Report

Running a Query

Marrative & Diagram :
I -basic

Summaries -spatial

WOV NV VNV VNV

Analysis > 000/738

Time Stamps for Sections

* 0:00 - Running a query

s 1:10 - Map Options

e 2:28 - Narrative/Crash Report I
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Tools LA_Unifo_155289 m Q - @

n Intersection Geometry l::'J

The general geometry of the intersection. An intersection consists of two or more roadways that intersect at

the same level. I:I:
"VT‘L Code Name Description
100 Angled / skewed An intersection of roads where the angle between the roads is og
4 significantly more or less than 90°. aa
Fl
E?t‘ 101 Roundabout / traffic circle Circular traffic patterns in which yield control uses all entries,

circulating vehicles have right of way, pedestrian access only allow
across the legs of the roundabout behind the yield line and circuiation
is counter-clockwise and passes to the right of the central island.

Intersections where vehicles must travel around a circle to continue on
the same road or leave on any intersecting road.

75
I ¥
435
al |
= ! S 2
4 W
| ¥
| &
102 Perpendicular An intersection of roads where the angle between the roads is almost
nearly 90°. @
Fl
70 Not applicable Not applicable. e k-

www.dotd.la.gov
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V% Initialization
» Crash Querying
» Site Analysis
» Quality Assurance
» Benefit-Cost
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Imits - Time
» Most recent: 6 to 18 months ago
»Minimum: 3 vears

> Preferred: 5 years

» Consistency

— Similar operations
— No major construction

www.dotd.la.gov
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Its - Segments

» Considerations
— Too small may be too close to randomness
— Too large may be too close to average

»Suggested limits

(miles) Urban Rural Class
Minimum 0.4 0.6 Highways
Maximum 2 3

Best |Between interchanges| Freeways

»If an end-point is at an intersection, trim it
to avoid the intersection’s functional area

www.dotd.la.gov
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S - Intersections

» Considerations
— Too small, may not capture all crashes
—Too large, may perform extra QA

»Minimum: 150 feet*
*but do not include other intersections

»Include all of the turn-lanes & taper*

» If too close to another intersection,
consider splitting the distance between
Intersections

www.dotd.la.gov



AAAAAAAAAAAAAAAAAAAAA u
TRANSPORTATION & DEVELOPMENT I1 1
—~ I I S

» Insufficient Crashes

— Intersections: <5 crashes / year

— Segments: <5 crashes / year / mile
» Remedy

— Increase geographic span

— Increase time span

www.dotd.la.gov
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nalysis Process

» Crash Query

» Quality Assurance

» Site Analysis

» Benefit-Cost Analysis
» Publish Results

www.dotd.la.gov
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[ Date Range ][ Location ][ Route

et ' |

> Query =4
Satellite

Map
> Tools SEE e

> Summary

> View

> Project

a

Enlleg%ﬂtatiun : 1
) Hel P "

Spring.
RHNOS

Gocgle Houston

0 mapped out of 0

Clear Filters

Control Section:

Load Crashes Reset

‘ 007-07]

Logmile From:

s

i}

-

Legmile Ta:
13.529

CLOSE

!
A }?u—r!?m—?ﬂﬂKEﬁgjﬂTlEEﬂfﬂyE“Ef
= — —t o 5

1ok
o

‘Beaumonto-

{ o PSSP L= R

oll L=t R

Crash Number

.L:gm“- '“:r;.‘-" | ra |
e son Meridie » 2
0 - ‘ Vicksburge  ¥IJ Ja;:_léson__ e idie .

,i 55 I Lg:rél
I~ o — : i ¥
3 ol glattiasbiig | @
| S Y oy M

%+ = = NationallEorests

| . ) =g
i.ﬂ.U_iSIﬁN-‘A £l | _
s Baton Rouge ./ : |

[ 5

EB _slidell < 00

f?ﬁ -L'.ll

o L Gulfpo

o : -:'il_-%-;:;..-.x.--:_-:‘r.a.‘.' 2
Newibeld New Orleans|

Keyboard shoriouts | Map data ©2023 Google, INEGI | Terms i.Heq:lcul a map error

—

MAP ICON LEGEND

i
5]




DOT
F"_z.%g

LOUISIANA DEPARTMENT OF
TRANSPORTATION & DEVELOPMENT

sh Queryin

Crash Query Tool
[ Date Range ] [ Locaticn ] [ Route ] [ Control Section ] Load Crashes ) Beset
——

> Query - oy '
Mﬂp Satellite Control Sectiom: |
> Summary 450-05 o - |
|
> Tools Logmile From: '
_ Evangeline i |
> View inoke - — 2 - I
Jennings |
Mermentau: Legmile To: |
: - i
> Project 3 - i
. |
CLOSE |
|
> He|p Laki.!_.f_-"ll'thur .
aD) Qo)
. (14) Gueydan
Google @) L Wright
0 mapped out of 0
Clear Filters
Mapped Crash Mumber Year
(AT M

Cankton

vatican

Scoft
f (3
La ayette D, Parks Catahoula
Walroy 1'1?'!-
@ (®73) Broussard LZk)
St Martinville
Maunce
Youngaville
i’ Cade 5 + |
1)
Loreauvill
fral i) (35
Keyboard shorlcuts | Map dala ©2023 Geogle, INEGI  Terms | Reporl a mag errar
MAP ICONMN LEGEND
B
Severity Manner of Callision Control Section
(Al > | (Al -

Carencro

Cecilia

-

1%

Breaux Bridge

Hendersan

Atchafal ™ 7
- i LoJ

I
S

Butte La Rose




DOT
;’—’_z.%g

LOUISIANA DEPARTMENT OF
TRANSPORTATION & DEVELOPMENT

Cu
i
=)
T
(%]
&
=
[=}
[
(1]
3

S &erying

136 “Sbryancostello &

Crash Query Tool

[ Date Range ] [ Location ] [ Route ] [ Control Section

> Query ;
HL Carriersq IR, R

@@"tﬂ

mmuome- e Park

> Summary
ABC 123 ice cream

> Toals

> View
> Project

> Help

P 1=iew D

A1 Safe & Lock 9 Rabhit Rd
Lou's Trailer Sales @

GO'-Q‘E ﬂ'r\,.:..l...'... Prmeadbia il AR

Juneau Metalworks 9

Kevboard sharlouts

Cquin Angus Farmo

PH 2a1ply

0 Arceneaux Rd

Map data & gle Terms Reporl a map error

55 mapped out of 55

Clear Filters

MAP ICON LEGEND

s
)
B

-

- - Yea Severity
- |4 (Al *
v 2018 104-(C) PROPERTY DAMAGE ONLY

104-(0) PROPERTY DAMAGE ONLY

104-(0) PROPERTY DAMAGE ONLY

Manner of LOM

Cont
(All) \\

505-SIDESWIPE - SAME DIRECTION 450-1

505-SIDESWIPE - SAME DIRECTION 450-1

300-FRONT TO REAR - REAR END l.la.gov




DOT
F"_—z:_\*--‘-g

LOUISIANA DEPARTMENT OF
TRANSPORTATION & DEVELOPMENT

sh Querying

Total Crashes: 0
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Crash Query Tool
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w Query
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» Spatial
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> View
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Total Crashes: 126 Fatal Injury Crashes: 1 jury Crashes: 33 Property Damage Only Crashes: 92 bryan.costello & ~
Crash Query Tool
[ Diate Range ] [ Location ] [ ]
v Query
Map  Satellite
Basic
s Spatial
By Search
Area
By Point
> Tools
> View
> Project | Report a map emror
126 mapped out of 126 MAP ICOMN LEGEMND
> Help Clear Filters = [
Mapped Year Severity Manner of Callision Cont
(Al a, (Al (Al - Q
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= B0 v 2018 104-(0) PROPERTY DAMAGE ONLY TOT-ANGLE - LEFT OPPOSITE DIREC... | 254-
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Total Crashes: 126 Fatal Injury Crashes: 7 Injury Crashes: 33  Property Damage Only Crashes: 92 bryan.costello & ~
Crash Query Tool
s Query
Basic v ; .
Within 200 feet of latitude 30.514872, longitude -91.026334
o Spanl 2018-1-1 to 2022-12-31
By Search G~
Area
By Point Hour Tot Acc Fatal Acc Imjury Ac PDO Acc MNum Fatalities MNum Severe |njuries(B) Num Moderate
A Summary 0 3 0 1 2 0 0
Alcohol 1 1 0 0 1 0 0
Control 5 2 0 1 1 0 0
Section
7 D 4 3 0 0
Day of Wesek
7 9 0 1 8 0 0
Intersection 8 9 0 2 7 0 0
Crash
9 B 0 0 B 0 0
Parish
) 10 2 e} 1 1 0 0
Pedestrian
Relation To " 12 0 2 10 0 0
Roadway 12 4 o 0 4 0 0
Route
13 7 0 3 4 0 0
Type of
Callision 4 4 o B 2 0 1
Work Zone 15 14 0 3 1 0 0

www.dotd.la.gov



DOT
F"_z.%g

LOUISIANA DEPARTMENT OF
TRANSPORTATION & DEVELOPMENT
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Crash Query Tool
v Query
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rash - Tools

Total Crashes: 409 Fatal Injury Crashes: 0  Injury Crashes; 108 Property Damage Only Crashes: 301 bryan.costello &~
Crash Query Tool
[ Date Range ] [ Location ] [ Route ] [ Controf Section ] E
2 Query TIBL A Really Hot Air Balloons o v W
H rA

Map Satellite p

7 Summary . - Ty
Beaver Creek

+ Tools Golf Course

w ° Milldale Baptist Churcho
&) The Hmﬂpm éﬁ
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|
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Port Hudson N
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> Help
Clear Filters iz [§
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Crash Query Tool
[ Date Range ][ Locatien ][ f 2 ][

Basic o« ,
“ Spatial

By Search

Area

By Point

> Summary

> Tools
> View
_ X . Keyboard shortcuts | Map date £2023 Imagery $2023 Aitbus, Maxar Technologies, U.S. Geelogical Survey, USDA/FPAC/GED | Terms | Report a map errdr
v Project 128 mapped out of 128 MAP ICON LEGEND
Clear Filters Dirag a column header here to group by that column = [f
My Projects
Mapped Crash Number Menth Year Day of Week Sevent
(All >~ Q Q Q Q (Al

> Help
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Crash Query Tool
[ Date Range ][ Locatien ][ f 2 ][

Basic o« ,
“ Spatial

By Search

Area

By Point

> Summary

> Tools
> View
X . Keyboard shortcuts | Map date £2023 Imagery $2023 Aitbus, Maxar Technologies, U.S. Geelogical Survey, USDA/FPAC/GED | Terms | Report a map errdr
v Project 128 mapped out of 128 MAP ICON LEGEND
Create
Proiect Clear Filtars Dirag a column header here to group by that column = [f
@ Mapped Crash Number Menth Year Day of Week Severity
(All >~ Q Q Q Q (Al
> Help
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New Project

Project Name Analysis Type Created By Created On Date Modified

LA 37 at Central Thwy

Intersection Analysis | bryan.costelle  10/31/2023 10/31/2023
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ash Analysis

Crash Query Tool
[ Date Range ][ Location ][ R

> Query Map Satellite
2 Summary
> Tools

v View

Query

> Project

v Analysis = 5 LR N

5 ugied._,!_]- Geological Survey |errna I-Repart a map afror

110 mapped out of 110
> Help PP MAP ICON LEGEND
Clear Filters Save Filter Drag a column header here to group by that column iz [§
Reviewed Mapped Manner of Collision Severity
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Crash Query Tool

» Query
> Summary
»> Tools

v View

Query

> Project

v Analysis

Intersection

> Help

Pattern Recognition Analysis - Intersection

o Project Name e Inputs o Farameters o Reaview

L= W

LA 37 at Central Thwy

Arigly

11/1/2023 ]

NEXT STEP
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section Analysis

> Query
> Summary
> Tools

s View

Cuery

> Project

v Analysis

Intersection

> Help

o Project Name

Date Range

Ctak Piate
atdr Liglie

1/1/2018

End Date

12/31/2022

Number of Lanes

Signalized/Unsignalized

® Signalized

Unsignalized

o Inputs o Parameters o Review

Rural/Urban

m Rural

® Urban

Divided/Undivided

® Dividad

Undivided

Number of Legs

(@) 4

PREVIOUS STEP NEXT STEP
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Crash Query Tool

Pattern Recognition Analysis - Intersection

> Query o Project Name e Inputs o Parameters o Review
> Summary
» Tools l—q:ad_rmmnr ~ ‘
v View GREENWELL 5PRINGS - NaN
Query LA 37 - 20524

CENTRAL - 10217

2 Project LA 37 - 20521
v Analysis CENTRAL - 10217

Intersaction PREVIOUS STEP MEXT STEP
> Help
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Crash Query Tool . _ e . .
Pattern Recognition Analysis - Intersection
> Query o Project Name o Inputs o Parameters o Review
> Summary
> Tools LA 37 - 20524 -
v View — Aadt Minor
CENTRAL - 10217 b
Query
Percent Lirmit
0.9Mm
> Project
Iinclude BCA:
“ Analysis
> Help
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Crash Query Tool .. * .
Pattern Recognition Analysis - Intersection
> Query o Project Name e Inputs o Parameters o Review
> Summary
> Tools Inputs Parameters
v View Project Name AADT Major AADT Minor
LA 37 at Central Thwy 20524 10217
Query
Analysis Date Percent L g
11/1/2023 0301 ichude. BEA
) Prcject Urban Mum Lanes
v Analysis e .
. Divided Signalized
IgEcean Divided Signalized
MNum Legs Start Dats
> Help 4 1/1/2018
End Date
12/31/2022
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section Analysis

Crash GQuery Tool
Pre-Preduction

> Query
> Summary
2 Tools

v View

Query

> Project

~ Analysis

Intersaction

> Help

Pattern Recognition Analysi

e Inputs

o Project Name

Inputs

Project Name

LA 37 at Central Thwy

Analysis Date

114142023

Lirban
Urban
Dnaded

Divided

Mum Legs

4

End Date

12/31/2022

rignalzed

S-iénalized

Start Date

17172018

Success - Catscan Calulation finished

o Parameters

Parameters
AADT Majar AADT Minor
20524 10217
Percent Limit |
0.901 Include BCA:

PREVIOUS STEP

VIEW RESULTS
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puts — Filters

> Filters-out crashes that does not
meet the below criteria

»Segment
— Within Grid
— Intersection = No
» Intersection
— Within Grid
— (Rural) Intersection = Yes
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ecognition Analysis

» Crash attribute as Binomial Trial

7 PX<x)= B(xnp)—z e iAot

_l)l

» Each trial compares: subject % v. class %
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Service Level

180 -

160 - 4

Crashes/mile/yr
® O N &
o OO O

0 20000 40000 60000 80000 100000
AADT

LOSS = Level of Service of Safety ~ Safety Level
LOSS 4 |: High potential for safety improvements

LOSS 3 |: Moderate potential for safety improvements
LOSS 2 |: Low potential for safety improvements
: Negligible potential for safety improvements
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Analysis

Code Categeory Obs % State % =>PRT Code Categeory Obs % State % =>PRT

Results
A Pecesirian 0% 0.59% MNao A MNan Coll 5% 3.31% Mo
i B Peczloycle 0% 0.42% MNo B Rear End 41% 45.66% Mo
> Project
C ATy 0% 0.03% Mo C —eza On 2% 0.93% Yes
» Analysis _
D 0% 0.75% No D Rt Angle 5% 14 51% Mo
Intersection . - _ o
E 1% 0.89% Mo E _eft Turn-g 0% 232% Mo
F 1% 0.25% Mo F Left Tum-f 349% 2.26% Ves
Hel . B , -~ - - -
’ P G 1% 1.02% Mo G Left Turn-g % 2.04% Mo
H Structures 0% 0.1% Mo H Right Turn-h 7% 2.73% Vas
] Train 0% 0.02% Mo Right Turn- 0% 0.43% Mo
4 Cithar Veh 0% 1.22% Mo ] S Swipe{sd) 4% 12.59% No
i Bus 0% 0.74% Mo 4 5 Swipelod) 1% 0.51% Mo
N Animal 0% 0.13% Mo Z Oiner 0% £.31% MNo
P Cther Fixed 1% 0.74% MNo
a Transport 8% 4.52% Yes
R 3+ Vences 4% 5.95% Mo
< Small Veh 52% 58.57% Mo
T Mizzelizneous 0% 0.3% Mo
0] Medium Veh 28% 21.94% Yes
% Errar 4% 0.82% s
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Safety Comparison

Expected Crashes

Ohserved: 100.0 Crashes/yr
Predicted (SPF): 127¢ Crashes/yr .
’ ~ B0th percentile
Over-dispersion: 459 80 == = 20th percentile
' == — GPE

Weighted 02 - *  Expected
Adjustment:
Observed: 100.0 Crashes/mile/yr &0
Expected 2403 Crasnes/mile/yr EE 5B
(SPF+EB): n

o
Safety Service @ T 40

m
Level: o )

30 ' —
Expected 100.0% = :
Percentile: \
80th Percentile: Z54% Crazsnes/mile/yr A R . -
Predicted (SPF): 737& Crashes/mile/yr
20th Percentile: 1122 Crashes/milefyr
20k 40k 60k 80k

AADT
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Expected Crashes with Injuries

Observed: 300 Crashes/yr
Predicted (5PF): 554 Crashes/yr 20 .
- - = B0th percentile
Over-dispersion: 47: == = 2(th percentile
. - —— SPF
Weighted 045 s FExpected
Adjustment: 15
Observed: 300 Crashes/milg/yr
Expected 18.91 Crashes/mile/yr E
(SPF+EB): ®
o 10
Safety Service e 'Frg L ——
Level: S ,-"' "‘--._____
Expected 99.97%
Percentile:
80th Percentile: 754 Crashes/milefyr
Predicted (S5PF): ::&4 Crashas/mile/yr
20th Percentile: 243 Crazsnes/mile/yr
20k 40k 60k BOk
AADT
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»Query:
— 2018 to 2022
—US 61 C-S 007-07 from LM 2.3 to 3.9

Total Crashes: 3¢ Fatal Injury Crashes: 1 Injury Crashes: 9 Property Damage O Crashes: 29 bryan.costello -
Crash Query Tool
[ Date Range ] [ Location ] [ Route ] [ Control Section ]
? Query it : £ —
. Jambalaya @@ v m ¥ A
Map  Satellite o Park THiETHat and MDFEQ (@) -
> Summary & indoor Flea Market
> Tools > St. Amant Muffler Holy Rosary
] {339) & Brake, Inc Catholic Church
> View :: St Amant Q Muffay’s Matket
: N
H [5: v r
~ Project & &r '
R W Ornce Roth Bd 3 AT
Create & g
Project z 9 Smith mlﬂh & Steel
My Projects i e i ew S +
i Fractor Supply '-UQ Ross Downing Buick ‘;’ South of Philly \
. GMC Of Gonzales S Brittany =
> Analysis Qu ke Anderson’s (3 )
fonzales —
GO g]? (va1) Cara's HI'.JIJ-‘JEO Keyboard shorfouts  Map data ©2023 Terms  Reporl a map error
> Help 39 mapped out of 39 MAP ICON LEGEND
Clear Filters Save Filter Drag a column header here to group by that column = [f
Reviewsd tanned 1

Intersection

Manner of Collision

Severiv
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New Project

ject MName —

test US 61 C-5 007-07 from LM 2.3 to

ANalysIis

Roadway Segment Analysis

al
CANCEL
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otal Crashes: 39 Fatal Imjury Crashes: 1 Injury Crashes: 8 Property Damage Only Crashes: 29 bryan.costello a~
Crash Query Tool D
[ Date Rangs ] [ Location ] [ Route ] [ Contrel Section ] oad Crashes
2 Query - . — -
: ambalaya G v m o oo
Map Satellite ! i Park Thig™THat and More a2 il
2 Summary & Indoor Flea Market
2 Toals v St. Amant Muffler Holy Rosary
I @ & Brake, Inc Catholic Church
2 View __ ‘ St Amant QMLJHWE Market
| o
. = 1. e k - R ir
~ Project . - q&;
Re W Orice Roth Rd '— XA R
Create AL

Project z QSFT'.‘;’h W S
My Projects Tractor Supply C n@

Ross Bowning Buick G’ South of Philly )
. GMC.0f Gonzales _ Brittany
(30) L30]

< St )

s Analysis Mike Ander

Sd), Cara's House o Keyboard shortcuts  Map data £2023 Terms  Report a map emror

39 mapped out of 39 MAP ICON LEGEND

> Help Clear Filtars Save Filter Drag a column header here to group by that column = [§
Reviewed Mapped Intersection Ma Severity
(A (Al | Q {All) > | (Al
hd NO 300-FRONT TO REAR - REAR END 104-(0) PROPERTY DAMAGE ON
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Crash Query Tool

> Query
> Summary
> Tools

> View

“ Project

Create
Project

My Projects
v Analysis

Roadway
Segment

> Help

bryan.costello & ~

Pattern Recognition Analysis - Roadway
o Inputs e Parameters

o Review

o Project Name

test US 61 C-5 007-07 from LM 2.3 to 3.9

11/7/2023 )
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Crash Query Tool

> Query
> Summary
> Tools

> View

~ Project

Create
Project

My Projects

v Analysis

Roadway
Segment

» Help

Fatal Injury C

o Project Name

Route

US 61

b Claes®
jWay L1355

Ur:ban 4-Lane Divided

1/1/2018

12/31/2023

rashes: 1 njury Crashes: 9 Property Damage Only Crashes: 29

bryan.costello & ~

Pattern Recognition Analysis - Roadway

o Inputs o Parameters

o Review

PREVIOUS STEP NEXT STEP.
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ment Analysis

Crash Query Tool

? Query
> Summary
? Tools

? View

v Project

Create
Project

My Projects

~ Analysis

Roadway
Segment

> Help

o Project Name

18,378

06

Sigma

0.02

Percent Limit

0.9

Include BCA:

heg O

Property Damage Only Crashes: 29 bryan.costello & ~

Pattern Recognition Analysis - Roadway
e Inputs

9 Parameters

o Review

PREVIOUS STEP @
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ment Analysis

Crash Query Tool

> Query
> Summary
? Tools

> View

~ Project

Create
Project

My Projects

v Analysis

Roadway
Segment

> Help

Fatal Injury Crashes: 1 Injury Crashes: @ Property Damage Cnly Crashes: 29 bryan.costello & =
LTy Uy

Success - Catscan Calulation finished

successfully.

Pattern Recognition Analysis

o Project Name e Inputs e Parameters o Review

Inputs Parameters
Project Name AADT g
test US 81 C-5 007-07 from LM 2.3 to 3.9 18378 0.6
Analysis Date Sigma Percent Li
11/7/2023 0.02 0.9
Route Cantrol Section * .
Us 61 007-07 Include BCA:
Logmile From Lagmile To
2.3 39
High Cla

Urban 4 Lane Divided

Start Date End Date

1}'1,’2018 12/31/2023

PREVIOUS STEP

Run Analysis
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Crash Query Tool

> Query
> Summary
> Tools

> View

v Project

Create
Project

My Projects

v Analysis

Roadway
Segment

> Help

Pattern

Control Section:

Log-mile from:
Logmile-to:
AADT:
Highway Class:

Period:

Code Crash Type

A Pedestrian 263% 0.89%
B Fecaloycls 0% 0.38%
C Ay 0% 0.05%
B Motorcycle 2:63% (083%
E Parked 263% 1™%

F Mot Fixed 0% 104%
G Vertical Fixed 7.:85% 2.85%
H Structuras 263% C:57%
] Train 0% 0.05%

Injury Crashes: 1

007-07

2.3

3.9

18378

Urban 4-Lane Divided

2018 - 2023

Obs %  State %

(o)

[

3

o

[

o

[

Recognition Analysis

Percent Limit:
Possible As:

AADT Group:

Deltas > Percent Limit

0%

0%

0%

0.6 miles
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0.5

50

low

Other Factors

[N

[

()

bryan.costello &~

Export to PDF
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Total Crashes: 39 Fatal Injury Crashes: 1 Injury Crashes: 9 Property Damage Only Crashes: 28 bryan.costello &~

My Projects
o Code Crash Type Obs % State %  Deltas > Percent Limit Code Other Factors Obs %  State %  Deltas > Percent Limit
~ Analysis

A e 26 08 0 o NI 0
Roadway

Segment B Pegaloycle 0% 0.38% 0 0% B Rezr End 3947% 441563% O 0%
C Ay 0% 0.05% 0 0% ¢ Head On 263%  088% 0 0%
> Help B} Motorcycle 263%. (093% 0 0% B Fr Angle 0% £12% g 0%
E Parked 263%  17% & 0% E Left Turn-= 263%  238% ] 0%
F Mot Fixed 0% 1.049% 0 0% F =ft Turn-f 526% 299%% 1 2%
G Vertical Fixed 789%% 2.85% 20 £0% G Left Turn-g 0% 2.68% 0 0%
H Siructurses 263% 0.57% 0 0% H Right Turn-h 0% 213% 0 0%
J Train 0% 0.05% 0 0% Right Turn- 0% 032% g 0%
K Other Veh 0% 1.15% 0 0% ] S Swipa(sd) 2105% 2062% ol 40%
M Bus 0% 0.38% 0 0% K 5 Swipsiod 0% 0.48% o 0%

N Animal 0%

i
LY
[y}
&
o
P}
i
Il
]
vt
Lo
J
al
[
S
o
L
s}
o

P Orher Fixed 526%: 295% 15 30% RD Road Depart 28:95% 14.98%

a Transport S2E%  3EI% 15 0% Le Darkw/o Lights  23.68% 7.46%

I 3= Venices 2.63% 5:48% & 0% Alc Alcoho 15.79% 27%

T Miscellansous 526%  1.72% G 0% Wet Wet Surface 13.36% 1597% 0 0%

Crash Type Crash Factor

www.dotd.la.gov
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Fatal Injury Crashes: 1 Injury Crashes: 9 Property Damage Only Crashes: 29 bryan.costello & ~
Crash Type Crash Factor
b3 rrr """“'h‘_ 1
P"‘---.-'-I-HH"'T
0.8 0.8
1] [
S S
0 0.6 U 0.6
0 "]
z Z
sl ]
2 04 8 04
o o
| |
o o
0.2 0.2
> 2.5 g 3.5 4 8 T2 3 3.5
Log Mile Log Mile
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Expected Crashes

Observed: £33 Crashes/yr 80th percentile
== w 20th percentile
Predicted (SPF): 2198 Crashes/yr - .
' 50 2 —— SPF
Over-dispersion: 1.04 ® Expected
Weighted Adjustment: G.01 &
o 40
Observed: 396 Crazhes/mile/yr g
&
Expected (SPF+EB): 458 Crashes/mile/yr g
b3
Safety Service Level: g
1]
. =
Expected Percentile: 24 86% -
|
80th Percentile: 22.04 Crashes/mile/yr o
Predicted (SPF): 13.74 Crashes/mile/yr
20th Percentile: 321 Crashas/mile/yr - - .

15k 20k 25k 30k 35k 40k

AADT

www.dotd.la.gov
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Expected Crashes with Injuries

Observed: 167 Crashesfyr . = = 80th percentile
Predicted (SPF): g Crachasur 14 a = == = 20th percentile
redicte : 6.7 Crashes/y - SPE
-
Over-dispersion: 1.28 = ® Expected
Weighted Adjustment: 0.05 i
o
Observed: 1.04 Crashes/milefyr g
~
Expected (SPF+EB): 119 Crashes/milefyr &
=
Safety Service Level: oy
]
. P
Expected Percentile: 19.55% =
I
80th Percentile: B.59 Crashes/milasfyr -
Predicted (SPF): 415 Crazhes/milg/yr
20th Percentile: 122 Crashes/milefyr

15k 20k 25k 30k 35k 40k
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Total Crashes: 39 Fatal Injury Crashes: 1 Injury Cr.

bryan.costello & ~

Crash Query Tool

Pattern Recognition Analysis

> Sy Control Section: Do7-07 A 0.6 miles
3 Yool Log-mile from: 2.3 &: 0.02 miles
e Logmile-to: 3.9 Percent Limit: 0.9
AADT: 18378 Possible As: 50
22::15'25 Highway Class:  Urban 4-Lane Divided AADT Group:  low
Period: 2018 - 2023
~ Project
Freita Code  Crash Type Obs % State % Deltas » Percent Limit Code  Other Factors Obs % State % Deltas > Percent Limit
Project A Pedastrian 263% O 0 0% A Non Co 28.95%  13.12% _
My Projects B Pedalcycle 0% 0.38% 0 0% 3 Rear End 3047% 4183% O 5]
~ Analysis C Aty 0% 0.05% 0 0% C 2ac On 263% 0.98% 0 0%
Roadway D Motorcycle 263% 0.93% 0 0% o AL Angle C% 6.12% 0 0%
Segment E Parked 263%  17% o 0% £ Left Turn-e 263% 238% 0 0
5 Mot Fixed 0% 1.04% 0 0% F Left Turn-f 5.26% 1 2%
> Help G Vs Fixed 7.85% 2.85% 20 400 G Left Turn-g 0% 0 0%
H Structurss 2.63% 0.57% 0 0% H Right Turn-h 0% 213% [ C%
J Train 0% 0.05% 0 0% Right Turn-i 0% 032% 0 0%
K Other Ven 0% 115% 0 0% J 5 Swipe(sd) 21.05% 20.62% 2 40%
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Recommendations if LOSS-3 or LOSS-4:

» Collision Manner
— Other
— Over-represented
» Non-Motorist over-represented
— Pedestrians
— Pedalcycle aka Bicycle
» Severity
— K: Fatal
— A: Serious
» Intersection

— True & not geographically at intersection
— False & geographically at intersection

Assurance

www.dotd.la.gov
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Y Investigate?

Most data elements from LEOs
~70% - 80% accurate
 Collision Manner — 76%
« Location at 0.05 mile threshold —
/5%
» Without Quality Assurance
— Analysis = Maybe True

» With Quality Assurance
— Analysis = Likely True

www.dotd.la.gov




AAAAAAAAAAAAAAAAAAAAA
T ENT

investigation?

»>NoO need to review
—error free crashes
—not road’s fault crashes
—not over-represented crashes

»Determining mitigation strategies —
theory of diminishing returns

www.dotd.la.gov
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AIEd

By Point

> Summary

> Tools
> View
< R . m_urtn Map data £2023 Imagery £2023 Airk
e PrﬂjECt 128 mapped out of 128 MAP |CON LEGEND
Craate
Project Clear Filters 5ave Filter Drag a column header here to group by that column iz [§
My Projects
ion Pedestrian Lat Long | Manner of Caollision Roadway Departure
Analysis
> y (Al * Q e ! (A - (Al i
30.514831 | -91.026382 | 505-5|DESWIPE - SAME DIRECTION
> Help
30.514865 | -91.026319  101-AMGLE - LEFT OPPOSITE DIRECTION
30.514865 -91.026319 200-FRONT TO FRONT - HEAD OM
30.514865 -91.026319 101-ANGLE - LEFT OPPOSITE DIRECTION
30.514865 —91626319%
5 10 20 Page 1 of 26 (128 items) |1 2 3 4 5 i 26
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- r | T +T* ::._,

By Point |“% P

~PerfecliB Gy . 20N RN J i
> Summary aitial Arts nt{Fresh Mar
»> Tools
> View
. ; e il !ﬂshurts

v Project 128 mapped out of 128 MAP ICON LEGEND

Create

Project Clear Filtars Save Filter Drag a column header here to group by that column = [f

iy Projects

Caly Pedestrian Lat Long | K Roadway Departure
> Analysis
LA ¥ R 3 ¢ 200-FRONT TO FRONT ... Al N
30.514831 -91.026382 5
> Help 300-FRONT TO REAR - ...
30.514865 -91.026319 1
501-ANGLE - RIGHT AC..
30.514865 -91.026319 2
C i s
30.514865 -91.026319 1 HWa-SIHESIWIEE - SAME
30.514865 -91.026319 3 980-0OTHER
5 10 20 2 3 4 5 26
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~ Query
Basic
v Spatial

By Search
Area

By Point
> Summary
> Tools

> View

v Project

Create
Project

My Projects

> Analysis

> Help

Map

Satellite

4 mapped out of 4

Clear Filters

on

(Al

Pedestrian

30.514865

30.514874

30.514349

30.514754

Save Filter

Long
Q,
-91.026319
-91.026303
-91.026349

-91.0263

Drag a column header here to group by that column

Manner of Collision m

(Al

980-0OTHER
980-0OTHER
980-0OTHER

980-0OTHER

-

(Al

Roadway Departure

[
2 [
&

Parish

Q

EAST BATON RO
EAST BATON RD

EAST BATON RO

EAST BATON RO
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Basic
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By Search
Area

By Point
> Summary
> Tools

> View

v Project

Create
Project

My Projects

> Analysis

> Help

-

Map

Satellite

4 mapped out of 4

Clear Filters

(Al
B8 0
e () Marrative & Diagram

Save Filter

Mapped

v

Drag a column header here to group by that column

Month

-

MAY

JANUARY

NOVEMBER

JANUARY

s

Year
Q,
2019
2021
2018

2018

Assurance
. i

Day of Week

Q

MOMNDAY

WEDMESDAY

MOMNDAY

THURSDAY

Severity

(Al

&

104-(C) PROPERTY DA

104-{0) PROPERTY DA

104-(C) PROPERTY DA

104-{0) PROPERTY DA
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By Search
Area

By Point
> Summary
> Tools

> View

» Project

Create
Project

My Projects

> Analysis

> Help

L

Map

Satellite

4 mapped out of 4

Clear Filters

(Al

-
2

Save Filter

Mapped

Drag a column header here to group by that column

-

' Month

az
ALY
JANUARY
MOVEMEBER

JAMNUARY

Year
Q

2019

2018

2018

Day of Week
Q,

MONDAY
WEDNESDAY
WION DAY

THURSDAY

[
D [
i

Severity
(Al
104-(0) PROPERTY DA

104-(0) PROPERTY DA

104-(0) PROPERTY DA

104-{0) PROPERTY DA




DOT
Fz::—D:

LOUISIANA DEPARTMENT OF
TRANSPORTATION & DEVELOPMENT

v Query
Basic
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By Search
Area

By Point
> Summary
> Tools

> View

~ Project

Create
Project

My Frojects

> Analysis

> Help

Map

4 mapped cut of 4

Clear Filters

ntrol Section

(A

=02

02

Satellite

Pedestrian

-

Save Filter

Lat
Q

30.514865

Q,

[

Drag a column header here to group by that column

Long | Manner of Collision Y

(Al * (A

-51.026319 @ 980-OTHER

30.514874

30.514849

30.514754

-91.026345 980-0OTHER

-91.0263 | 980-OTHER

MAP ICON LEGEND

Roadway Departure
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s Query
Easic
» Spatial

By Search
Area

By Point
> Summary
> Tools

> View

~ Project

Create
Project

My Projects

> Analysis

> Help

L

Map  Satellite

4 mapped out of 4

Clear Filters

(Al

-
%

Save Filter

Mapped

Drag a column header here to group by that column

-

' Month

@

MAY

JANUARY

Year

Q,

2019

Cray of Week
Q,
MONDAY

WEDNESDAY

MAP ICON LEGEND

Severity
(Al
104-(0) PROPERTY DA

104-(0) PROPERTY DA
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JANUARY

2018

2018

MOMNDAY

THURSDAY

104-(0) PROPERTY DA
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Assurance

Crash Query Tool
[ Date Range ] [ Location ] [ Rout

N
v Query Satellite

Basic
~ Spatial

By Search
Area

By Point

> Summary
> Tools

> View

v Project 2 mapped out of 2 MAP ICON LEGEND

Craate
Project Clear Filtars : Save Filter Drag a column header here to group by that column

J

Cs

.
[
8

My Projects i _ :
I | Manth T | Year Cay of Week Severity I log Mile | Intersection
Analysis ' ' '
2ty - @ Q Q (Al - Q Q
APRIL 2019 THURSDAY 101-(A) SUSPECTED SERIOUS INJURY 4.522 | YES

> Help
AFRIL 2022 FRIDAY 100-(K) FATAL INJURY 3653 | YES
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By Search
Area

By Point
> Summary
? Tools

> View

v Project 2 mapped out of 2 MAP ICON LEGEND

Create
Project Clear Filters Save Filter Drag a column header here to group by that column

My Projects
Mapped Month Year Day of Week @

> Analysis (A + | Q Q (Al

THURSDAY

> Help

101-{A) SUSPECTED SE

Pl il APRIL 2022 FRIDAY 100-(K) FATAL INJURY
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By Search
Area

By Point
> Summary
> Tools

> View

~ Project

Create
Project
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> Analysis

> Help

Map  Satellite

P,

ﬁt.:FFesh Markél

Bl _ kevboard shoricuts

25 mapped out of 25

Clear Filtars

severity

Al -
104-{0) PROPERTY DAMAGE ONLY
104-{0) PROPERTY DAMAGE OMNLY

104-(0) PROPERTY DAMAGE ONLY

103-(C) POSSIBLE INJURY

104-{0) PROPERTY DAMAGE ONLY

%y

Map data £2023 imagery #2023 Aitbus, Maxar Technologies, ULS.

MAP ICON LEGEND

Save Filter Crag a column header here to group by that column
Log Mile | Intersection @Contrml Section Pedestrian
Q Q Q (AT -
0| NO -1
4522 NO 254-02
4522  NO 254-02
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[
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33 Property Dama inly Crashes: 92 bryan.::-::sfzello:1r

Total Crashes: 126 Fatal Injury Crashes: 1 Injury Crashes:

Crash Query Tool

Pattern Recognition Analysis - Intersection

» Query
o Project Name e Inputs e Parameters o BCA Inputs e Review
> Summary
» Tools o
. LA 37 - 20520 -
> View
Aadt Minor
CENTRAL - 10217 -
~ Project _
Percent Li
Create 09024
Project

My Projects
i PREVIOUS STEP NEXT STEP

Intersection

> Help

www.dotd.la.gov
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enefit-Cost

Total Crashes: 126 Fatal Injury Crashes: 1 Injury Crashes: 33 Property Damage Only Crashes: 82 bryan.costello & ~

Crash Query Tool

Pattern Recognition Analysis - Intersection

> Query

o Project Name o Inputs o Parameters o BCA Inputs o Review

> Summary

> Tools
CMF Cost
> View
CME Clearinghouse
i jur) Caonstruction {
v Project bt .
Create .
ecied oo eering Co
Project = Inj . (&ngw erin —
My Projects : _
- - D - Fe
s Analysis - -
Intersection E = Utilities Co _
- D -
= afma T = ire, .
> Help v 3% .

PREVIOUS STEP NEXT STEP
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Pattern Recognition Analysis - Intersection

Benefit-Cost Analysis

Project Name: test LA 37 at Central Thwy Intersection Cl... Urban 4-Lane 4-leg CMF Clearing
Major AADT: 20520 Period: 2018 - 2022
£4,704,723.00
Minor AADT: 10217 Duration: 5 years
$10,000.00
gnefit-Cost Ratio: 470.47
Code Categeory Obs % State % >PRT Code Categeory Obs % State % >PRT
& Pedesirian 0% 0.59% Ne A Mon Co 403% 331% No
B Peoaloycle 0% 0.42% Mo B Rear End 41.13% 45.66% No
£ Ay 0% 0.03% Mo C Head On 4.84% 083% Yas
D hMaotorcycle 0% D.75% Mo D Rt Angle 5.65% 14.91% No
E arked 0.81% 0.85% Mo E Left Turn-2 0% 2.32% No
F Mot Fixed 0.81% 0.25% No F Left Turn-f 25% 8.26% ez
G Wertical Fixed 0.81% 1.02% MNe G L=ft Turn-g 0.81% 2.04% No
H Structures 0% 0.1% Me H Right Turn-h 5.85% 2.73% bEH
] Train 0% 0.02% MNo Right Turn-i 0.8%% 0.43% MNo
K Dther Veh 0% 1.22% No J S Swipe(sa) 11.29% 12.29% No
M Bus 0% 074% Mo 4 % Swipelod) 0% 031% MNo
N Animal 0% 013% No Z Crther 0.81% 5.31% No

www.dotd.la.gov
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